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Alberta Electronic Immunization/Adverse Reaction to Immunization 

(Imm/ARI) 

Introduction 

Immunization is one of the most important and cost-effective public health innovations. In Canada, immunizations have 

saved more lives than any other health intervention and have contributed to the reduction in morbidity and mortality 

from a broad range of vaccine-preventable diseases in adults, children, and other vulnerable populations. Access to 

information on vaccinations is an important element in patient care. To address this, Alberta Health has created an 

immunization data repository known as Imm/ARI, which is short for Immunization/ARI (Adverse Reaction to 

Immunization). 

A number of years ago, a piece of legislation entitled Immunization Regulation was passed that require all Alberta Health 

Care Providers (HCPs) who administer vaccinations to electronically contribute data to Imm/ARI. For further information 

click this hyperlink https://open.alberta.ca/publications/2018_182 . Alberta Health has created a portal that enables 

practitioners to electronically submit data. This is a standalone tool and is not integrated with the Kroll system. In 

addition, publicly funded vaccinations (e.g. Influenza and COVID-19) had their information sent to Imm/ARI via a feed 

from the Alberta Blue Cross adjudication engine. This functionality will be discontinued in the very near future and all 

vaccinations will need to be entered via the portal. 

To improve efficiency and reduce the risk of data transcription errors, the Kroll Team at TELUS Health has developed 

an interface that will enable customers to electronically send vaccination information to the Imm/ARI repository directly 

from their Kroll systems. 

This user guide provides customers insight into the elements of Kroll related to the Imm/ARI integration and how to 

utilize them.
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Enable Alberta Imm/ARI 

 

The Imm/ARI module was activated in your system through either an update that was ran the night before or the 

morning of the activation.  

 

Required Store configuration option  

File > Configuration > Store > Rx > 8 - Immunization 

 

Prerequisite: The Imm/ARI module requires Real Time Integration (RTI) with the Alberta Pharmacy Information 

Network (PIN).  

Before proceeding: 

 Verify that PIN RTI is enabled and configured in your Kroll system. 
 Note: Disabling PIN RTI will prevent vaccination data submission to both PIN and Imm/ARI 
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The option labelled Record immunization when filling an immunization product or fee Rx not already linked to an 

immunization was turned on (checked as noted in the screenshot above) by an update that was ran when your Kroll 

System was activated on Imm/ARI.  This store configuration option MUST remain checked at all times.   

 

Store configuration option to enable Electronic Immunizations 

If you wish to use the Kroll Immunization Module-Electronic Mode, please follow the following steps:  

File > Configuration > Store > Rx > 8 – Immunization

 

• Enable electronic immunizations: Switches the immunization module from Paper mode to Electronic mode. When 

enabled, all documentation related to immunization (except for the patient consent form) occurs on- screen rather 

than needing to print and scan the information back into Kroll. 

• Require electronic signature for Pharmacists: When this option is enabled, pharmacists must provide an electronic 

signature when finalizing immunizations. A compatible digital signature tablet or virtual signature pad is required. 
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• Require UPC Verification of Vaccine Product: When enabled, users must scan or enter the vaccine’s UPC barcode 

suring immunization entry. The UPC must be pre-configured in the product’s drug card for verification to succeed. 

 

 

• Allow to use non-influenza immunization products obtained externally:   Enables pharmacist to administer and 

document non-influenza vaccines that were not dispensed by their pharmacy. The immunization is still submitted to 

Imm/ARI.  

Example scenarios: 

• The patient brings in a vaccine dispensed by another pharmacy. 
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• The vaccine necessitates more than one dose and the patient must wait before the subsequent injection can occur. 

 

• Print immunization wallet card:  Prompts user to print a wallet card-sized immunization card when finalizing an 

immunization, with options to customize which immunization types appear on the card.  

 

• Allow to use non-influenza immunization Rxs dispensed __ days ago:  Sets the time window (in days) for linking a 

previously dispenses immunization prescription to a new immunization record. This allows pharmacist to document 

administration of vaccines dispensed up to [X| day prior. 

Example: If set to 30 days, a vaccine dispensed 25 days ago can still be linked when documenting the immunization 

administration. 
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Record immunization when filling an immunization product or fee Rx not already linked to an immunization:  

Automatically prompts users to create an immunization record when dispensing a vaccine product or immunization-

related fee prescription outside the immunization module. 

Workflow: 

User dispenses an immunization product via standard prescription filling (not through immunization module) 

After finalizing the prescription, the Immunization Data Entry window appears 

User can either: 

 Create a new immunization record 
 Link to an existing immunization record (for multi-dose vaccines) 
 Skip (if administration will occur later) 

 

Setting up Drug Cards 

For immunization products, two key fields control vaccine identification and reporting to Imm/ARI: 

1. Drug Card Type (pre-existing field) 

 Influenza Immunization 

 Non-Influenza Immunization 

 COVID-19 Immunization 

 

2. Vaccine (new field when Imm/ARI module is enabled) 

 Located under the Other tab on the Drug Card 

 Default value: Unknown 

 Maps to specific vaccine codes sent to Imm/ARI 
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 When the Imm/ARI module is enabled, a new Vaccine field appears on the Drug Card under the Other tab. 

This field maps immunization products to specific vaccine codes required for Imm/ARI reporting. 

Field Locations 

 Drug Card Type: Pre-existing field that categorizes products as: 

 Influenza Immunization 

 Non-Influenza Immunization 

 COVID-19 Immunization 

 

 Vaccine: New field (Other tab on Drug Card) 

 Default: Unknown 

 Purpose: Specifies the exact vaccine code sent to Imm/ARI 

 

 

Initial Configuration 

The Vaccine field may be pre-populated through: 
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 Automatic TELUS Health updates for common vaccines 

 Manual selection by pharmacy staff 

If the field remains "Unknown," users must select the vaccine type when documenting immunizations. 

 

Workflow: Setting the Vaccine Type 

First-Time Selection (Drug Card = "Unknown") 

 

1. Open Immunization Data Entry for a patient 

2. Select the appropriate vaccine in the Vaccine field (Product tab) 

3. Click Record 

4. System prompts: "Do you want to update the Vaccine field on the Drug Card?" 

 Yes: Saves selection to Drug Card; auto-populates future immunizations 

 No: Applies only to current record; prompt repeats next time 

Changing an Existing Vaccine Type 

1. Immunization Data Entry auto-populates the Vaccine field from the Drug Card 

2. User modifies the vaccine type (if needed) 

3. Click Record 

4. System prompts: "The vaccine type has changed. Update the Drug Card?" 

 Yes: Updates Drug Card with new value 
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 No: Retains original Drug Card value; change applies only to current record 

 

Fee for Service Drug Card 

Administration Fees for Non-Publicly Funded Vaccines 

Selecting an Administration Fee 

When billing for a non-publicly funded vaccine, use the Administration fee field on the Administration tab to 

select the appropriate fee-for-service drug card. 

Pre-loaded Fee Drug Cards: 

The system includes standard administration fee drug cards: 

PDIN 00071111: Patient Assessment Without APA 

PDIN 00081111: Patient Assessment With APA 

Note: PDIN = Pseudo Drug Identification Number 

Vaccine-Specific Fee Drug Cards: 

Some immunizations have designated fee drug cards, such as: 

 DTaP Immunization Fee 

 Prevnar 20 Immunization Fee 

Consult your pharmacy's fee schedule or the Alberta Blue Cross resources for the complete list. 

Free of Charge Option 

To waive the administration fee (e.g., for promotional clinics or patient assistance programs), select "Free Of 

Charge" from the dropdown. This bypasses the fee billing process entirely.  

 

Special Services Codes (SSC) 

When submitting claims to the Alberta Public Health Activities Program (ABPHAP), the system may prompt 

you to enter a Special Services Code (SSC) corresponding to the clinical service provided. 

When SSC is required: 

 Specific immunization types designated by ABPHAP 
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 Enhanced clinical services (e.g., extended patient counseling) 

 

Where to find SSC information: Refer to the Alberta Blue Cross Pharmacy Resources page for current SSC 

requirements and fee schedules: https://www.ab.bluecross.ca/provider/type/pharmacy/resources.php 

 

Processing Vaccines in Kroll when the Imm/ARI module is activated 

Overview 

Kroll provides three methods for processing immunizations. With the activation of the Imm/ARI module, all thr

ee methods remain available with enhancements to ensure complete data submission to Imm/ARI and PIN. 

 

Available Processing Methods 

1. Kroll Immunization Module (Electronic Mode) - Direct electronic data entry and submission 

2. Kroll Immunization Module (Paper Mode) - Print- based workflow with subsequent electronic 

submission  

3. F12 Fill Screen - Standard prescription filling workflow adapted for immunizations 

 

What Changed with Imm/ARI Activation 

Automatic Network Submission 

Previously, users were prompted to manually confirm network submission: 

 ❌ Before: "Send to the network?" prompt appeared 

 ❌ Before: "Record on network" checkbox required user selection 
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With Imm/ARI enabled: 

 ✅ Now: These prompts are disabled 

 ✅ Now: All immunizations automatically transmit to Imm/ARI and PIN 

 ✅ Benefit: Streamlined workflow, reduced manual steps, ensures compliance 

Enhanced Data Collection 

Minor enhancements ensure all required fields are captured, documented, and transmitted to  

Imm/ARI. 

 

Using the Kroll Immunization Module 

Step 1: Select Immunization Type 

When creating an immunization record on the patient card, select the immunization category: 

 Influenza - Seasonal flu vaccines 

 Non-influenza - All other vaccines (shingles, pneumonia, travel vaccines, etc.) 

 COVID-19 - COVID-19 vaccines and boosters 

The system filters available products based on your selection. 

Step 2: Choose Processing Mode 

Mode Action Workflow 

Electronic Mode 
Click 

Perform Now 

Opens Immunization Data Entry screen for immediate electronic 

processing 

Paper Mode Click Print Now Prints immunization record; complete electronic submission later 

 

📝 Note: All patient examples in this guide use fictitious test data for demonstration purposes. 

 

Filling a Non-Influenza Immunization (Electronic mode) 

Scenario Overview 

Scenario 1: Fill a New Prescription  

 When to use: Standard workflow for dispensing and administering immunization products. 
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 Default option when processing non-influenza immunizations 

Scenario 2: Use a Product Obtained Externally 

 When to use: Patient brings a vaccine obtained from another pharmacy or provider 

 Requires: Configuration option enabled (File > Configuration > Store > Rx > 8 - Immunization > " Allow 

use of non-influenza immunization products obtained externally") 

 Example scenarios: 

 Patient brings vaccine dispensed by another pharmacy 

 The vaccine necessitates more than one dose and the patient must wait before the subsequent 

injection can occur. 

 

Scenario 1: Filling a New Prescription for an Immunization Product  

Step 1: Access the Patient Profile and Immunization Module  

1. Press F3 to search for and open the patient profile 

2. In the right-hand ribbon under View, select Immunizations 

 

3. Press N (New Immunization) or click Ins 
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Step 2: Select Immunization Type 

1. In the Immunization Type window, select Non-Influenza from the dropdown 

2. Click Perform Now to proceed to electronic data entry 

Immunization Type selection window 

 

 

Step 3: Rx Tab - Select Product  

Default Option: "Fill a new Rx" appears in the Rx Options dropdown 

1. Verify "Fill a new Rx" is selected 

2. Select the Product from the dropdown 

3. Pack Size and UPC fields auto-populate based on the drug card configuration 

4. Click Next 
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 Rx tab with product selection

 

📝 Note: If the UPC field is blank, you may need to configure it on the drug card. 

 

Step 4: Emergency Contact 

Enter emergency contact information for the patient: 

Option A: Manual Entry 

 Type the contact name and details directly in the Select Contact field 

Option B: Link to Existing Patient 

 Click the magnifying glass icon to search the patient database 

 Select an existing patient profile to use as the emergency contact 

Click Next to proceed. 
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Emergency Contact tab

 

📝 Note: If the patient has an emergency contact saved on the Other tab of their patient card, the contact’s 

information will pre-populate in the Emergency Contact fields. If there is more than one emergency contact linked to the 

patient profile, the user may select from the drop-down list where <Free-form> text appears. 
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Step 5: Patient Consent  

Complete the Consent Questionnaire  

1. Answer all questions using the dropdown menus 

2. All questions must be answered before the Print Consent button becomes enabled 
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Patient Consent questionnaire

 

If Patient is Eligible: 

1. Click Print Consent 

2. The Immunization Report window appears 

3. Click Print to generate the consent form 

4. Have the patient/guardian and pharmacist sign the printed form 

5. Proceed to scan the signed form back into Kroll 
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If Patient is Ineligible: 

1. The Patient Consent tab becomes read-only 

 

2. Click Refuse Immunization and the immunization will not be recorded on PIN. Follow steps as outlined under the  

Refused_Immuizations section. 

 

Step 6: Scan Consent 

If a document scanner is detected: 

Option Description 

Scan Patient Consent Form Scan the signed consent form directly into the system 

Select from Network Scan Import a consent form already scanned into Kroll 
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Option Description 

Proceed without Scan Continue without attaching the consent form 

If no scanner is detected: 

Option Description 

Select from File Browse and import the consent form from your computer 

Select from Network Scan Import a consent form already scanned into Kroll 

Proceed without Scan Continue without attaching the consent form 

Click Next after scanning or selecting an option. 

Scan Consent options 

 

 

Step 7: Product Tab - Enter Product Details  

Enter the following required fields: 

Field Description Source 

Disp Qty Quantity dispensed Manual entry 

Lot Number Vaccine lot number From vaccine packaging 

Expiry Date Vaccine expiration date From vaccine packaging 

Vaccine Vaccine type Dropdown (pre-populated if configured on drug card) 
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Field Description Source 

Manufacturer Vaccine manufacturer Dropdown or auto-populated 

Note: All fields must be completed before the Bill Product button becomes enabled. 

Click Bill Product to proceed to prescription filling. 

Product tab with required fields

 

 

Step 8: Bill Product - F12 Fill Screen  

The F12 Fill Rx screen opens with information pre-populated from the Product tab. 

Doctor Card Auto-Population: 

For Schedule 1 Immunizations (Prescription Required):  
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 Pharmacists with Additional Prescribing Authorization (APA)  flagged in their user 

profile (Edit > Users and Groups) can prescribe these immunizations. 

 

 The Doctor Card auto-populates with the pharmacist's prescriber information 

For Schedule 2 Immunizations (No Prescription Required):  

 The Doctor Card auto-populates appropriately 

Complete the prescription:  

1. Verify all information is correct 

2. Process the prescription as normal 

3. Upon completion, you return to the Immunization module Product tab. Click Next to proceed. 
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 F12 Fill screen for immunization product

 

 

Step 9: Locations 

Verify and update location information: 

Patient Address: 

 Auto-populates from the patient profile 

 Province, Postal Code, and Country are editable 

 Check Homeless if applicable (makes all fields except Country read-only) 

Store Address: 

 Auto-populates from store configuration (File > Configuration > Store > General) 

 Province, Postal Code, and Country are editable 

Click Next to proceed. 
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Locations tab

 

 

Step 10: Administration 

Enter the clinical administration details: 

Required Fields: 

Field Description Options/Notes 

Date of admin Date vaccine was administered Date picker 

Administered by Person who administered the vaccine Dropdown from Edit > Users and Groups 

Administration site Body location of injection Dropdown (e.g., Left deltoid, Right deltoid) 

Administration reason Reason for immunization Dropdown (options vary by vaccine type) 

Administration fee Fee for service billing Dropdown (see note below) 

Administration Fee Options:  

📝 Note: This field only appears for non-publicly funded vaccines. 
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Select the appropriate fee-for-service drug card: 

 PDIN 00071111: Patient Assessment Without APA 

 PDIN 00081111: Patient Assessment With APA 

 Vaccine-specific fees: (e.g., DTaP Immunization Fee, Prevnar 20 Immunization Fee) 

 Free Of Charge: Waives the administration fee 

Selecting a fee option triggers the F12 Fill screen to process the administration fee. 

Optional Field: 

 Subsequent doses: If the vaccine requires multiple doses, enter follow-up information 

 Administration tab

 

Immunization Follow-up  

Under Next planned immunization dates, click the person icon far right on the Dose field. This allows the user to decide 

if they want to follow-up with the patient and create an appointment after the original immunization has occurred. 
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The Immunization Follow-up screen will display. 

Option Description 

Book follow-up appointment Opens the Calendar to create an appointment 

Follow-up required in __ days Creates a To-Do entry in F9-Workflow for the specified number of days in the future 

Click Save and then Finalize Immunization. 
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 Immunization Follow-up prompt

 

The Immunization is sent and recorded on Imm/ARI in the background. 

 

Step 12: Print Immunization Record  

A prompt appears: "Do you want to print Immunization Record for the patient?" 

 Yes: Prints the immunization record for the patient 

 No: Saves without printing (can be printed later) 

Print confirmation prompt 

 

The Immunization Wallet Car selection window appears if there is a planned next dose and the user can pick which 

immunization type and then Print. 
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Step 13: Bill Administration Fee (if applicable)  

If an administration fee was selected, the F12 Fill screen opens: 

 Sig auto-populates with "Non-Influenza" 

 Clinical plan is removed 

 Fee-for-service drug card is pre-populated 

Complete the prescription filling process. 
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F12 Fill screen for administration fee

 

 

Viewing and Reprinting Immunization Records 

To view a completed immunization:  

1. Open the patient's Immunizations module 

2. Highlight the immunization record 

3. Press F2 to open the Immunization View 

 

 

Immunization View Tabs: 

Immunization Tab: 
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 Contains 5 sub-tabs showing all data entered during the workflow 

 Click Print to reprint the immunization record 

 Choose Print or Preview 

 

Documents Tab: 

 Displays the scanned patient consent form 

 Click the Printer icon to reprint the consent form 

Immunization View window 
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Alternative Method: 

 Highlight the immunization in the Immunization History screen 

 Press P (Print/Reprint) 
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Scenario 2: Performing an Immunization for a Product Obtained Externally  

When to Use: Patient brings a vaccine obtained from another pharmacy, clinic, or provider. 

Prerequisites: 

 Configuration option must be enabled: File > Configuration > Store > Rx > 8 - Immunization 

 Enable "Allow use of non-influenza immunization products obtained externally" 

 

Workflow Overview 

The workflow is similar to Scenario 1 with these key differences: 

1. Select "Use a Product obtained externally" in the Rx Options dropdown 

2. The prescription is flagged as "Not Dispensed" 

3. The immunization still transmits to Imm/ARI 

 

Step-by-Step Instructions 

Step 1: Access Immunization Module  

1. Open the patient card 

2. Select Immunizations in the right-hand ribbon 
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3. Press Ins (or N for New Immunization) 

4. Select Non-Influenza 

5. Click Perform Now 

 Immunization Type selection

 

 

Step 2: Rx Tab - Select External Product  

1. Under Rx Options, select Use a Product obtained externally 

2. Select the Product from the dropdown 

3. Click Next 
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Rx Options with "Use a Product obtained externally" selected

 

📝 Note: This option only appears if the configuration setting is enabled. 

 

Step 3: Emergency Contact 

Enter emergency contact information (same as Scenario 1). 

Click Next. 
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Emergency Contact tab

 

 

Step 4: Patient Consent  

1. Complete the consent questionnaire 

2. Click Print Consent 

3. Have the patient/guardian and pharmacist sign the form 

Click Next. 
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Patient Consent tab

 

 

Step 5: Scan Consent 

Choose a scan option to attach the signed consent form. 

Click Next. 
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Scan Consent options

 

Step 6: Product Tab 

Enter the required product details: 

 Disp Qty 

 Lot Number 

 Expiry Date 

 Vaccine 

 Manufacturer 

Click Bill Product. 



38 

 

Product tab for externally obtained product

 

 

Step 7: Bill Product - Not Dispensed Prescription  

The F12 Fill screen opens with the immunization product flagged as Not Dispensed. 

Key Difference: The product is not actually dispensed by your pharmacy, so inventory is not affected. 

Complete the adjudication process. 
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F12 Fill screen showing "Not Dispensed" flag

 

 

Step 8: Administration Tab 

Enter the administration details (same as Scenario 1): 

 Date of admin 

 Administered by 

 Administration site 

 Administration reason 

 Administration fee (if applicable) 

Click Finalize Immunization. 

The immunization is transmitted to Imm/ARI. 
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Administration tab

 

 

Step 9: Verify Submission  

In the Immunizations Module: 

 The record shows the immunization was obtained externally and uploaded to Imm/ARI 

Immunization History showing externally obtained product 

 

On the Network Patient Profile: 

 Shows the non-influenza immunization product as Other Medication/Not Disp. 

 Immunizations tab: Shows the immunization recorded on Imm/ARI 
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Network Patient Profile showing externally obtained immunization

 

 

 

Recording Emergency Epinephrine Shots (Electronic mode) 

Record an epinephrine injection when: 

 A patient experiences an adverse reaction to an immunization 

 Epinephrine was administered as emergency treatment 
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 The immunization record is already completed in Kroll 

📝 Note: The epinephrine administration is linked to the specific immunization that caused the reaction and is reported t

o Imm/ARI. 

 

Prerequisites 

Before using this feature, ensure: 

 ✅ Epinephrine products are configured in Kroll drug cards 

 ✅ The original immunization record is completed in Kroll 

 

Step-by-Step Documentation Procedure 

Step 1: Access the Patient Profile  

1. Press F3 to search for and open the patient card 

2. In the right-hand ribbon under View, select Immunizations 

 

Step 2: Link Epinephrine to the Immunization Record  

1. Locate the immunization record that caused the adverse reaction 

2. Right-click on the immunization record 

3. Select Add Epinephrine shot 

Right-click menu with "Add Epinephrine shot" option

 

 Important: Select the specific immunization that triggered the adverse reaction. The Epinephrine 

administration will be linked to this record. 

 

Step 3: Product Tab - Select Epinephrine Product  

The Emergency Epinephrine window opens on the Product tab. 
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1. Select the epinephrine product from the dropdown 

 Example: EpiPen, EpiPen Jr., or epinephrine injection 

 

2. Complete the required fields: 

Field Description Example 

Disp Qty Quantity administered 1 

Route Administration route Intramuscular (IM), Subcutaneous (SC) 

Lot Number Product lot number From epinephrine packaging 

Expiry Date Product expiration date From epinephrine packaging 

3. Click Next 

Emergency Epinephrine Product tab

 

📝 Note: All fields must be completed before you can proceed. 

 

Step 4: Administration Tab - Record Administration Details  
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The Administration tab displays with the Date of admin pre-populate with the current date and time.  

1. Select Administered by from the dropdown 

 Choose the healthcare provider who administered the epinephrine 

2. Select Administration site from the dropdown 

 Choose the injection location (e.g., Left thigh, Right thigh, Left deltoid) 

3. Click Finalize Immunization 

Emergency Epinephrine Administration tab

 

 

Step 5: Immunization Follow-up  

The Immunization Follow-up window appears. 

Select the appropriate option: 

Option When to Use 

Book follow-up appointment Schedule a follow-up visit to monitor the patient 

Follow-up required in __ days Create a reminder for follow-up contact 

Do no follow-up No automated follow-up needed (not recommended for adverse reactions) 

Recommendation: Always schedule follow-up for patients who experienced adverse reactions requiring epinephrine. 
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Click Save. 

 Immunization Follow-up options

 

 

Step 6: Bill Epinephrine Administration  

The F12 Fill Rx screen opens with the epinephrine product pre-populated. 

1. Verify all information is correct: 

 Product matches the epinephrine administered 

 Quantity is correct 

 Date/time reflects the emergency administration 

2. Complete the prescription filling process 

3. Process billing according to your pharmacy's emergency medication protocols 
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F12 Fill screen for epinephrine

 

📝 Note: Billing procedures for emergency epinephrine may differ from standard 

immunization fees. Consult your pharmacy's billing guidelines. 

 

Step 7: Verify Documentation  

After completing the workflow: 

1. Return to the patient's Immunizations module 

2. Verify the epinephrine administration is linked to the immunization record. The number for the linked emergency 

epinephrine will display the immunization number that is linked to follow by a -1. (Example: Immunization number 

is 63, the epinephrine is 63-1) 

3. Confirm the emergency epinephrine was transmitted to PIN 

 Immunization record showing linked epinephrine administration
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Filling a Non-Influenza Immunization (Paper mode) 

Processing Non-Influenza Immunizations (Paper Mode)  

 

Overview 

What is Paper Mode? 

Paper mode allows immunization documentation using printed forms that are completed manually, scanned back into 

Kroll, and then processed electronically. 

Paper Mode will be used when: 

 Electronic immunization configuration is disabled in your store 

 Preference for paper-based documentation 

📝 Note: Even in Paper mode, immunization data must ultimately be entered electronically 

and transmitted to Imm/ARI and PIN. 

 

Configuration 

Enabling/Disabling Paper Mode:  
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Paper mode is controlled by the Electronic Immunizations setting: 

 Navigate to: File > Configuration > Store > Rx > 8 - Immunization  

 When Electronic Immunizations is disabled, the system operates in Paper mode 

 When Electronic Immunizations is enabled, the system operates in Electronic mode 

 

Step-by-Step Instructions 

Step 1: Access Patient Profile and Immunization Module  

1. Press F3 to search for and open the patient profile 

2. In the right-hand ribbon under View, select Immunizations 

3. Press N (New Immunization) or click Ins 

Accessing the Immunization module

 

 

Step 2: Select Immunization Type and Print Mode  

1. The Immunization Type window opens 

2. Select Non-Influenza from the dropdown 

3. Click Print Now (Paper mode option) 
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Immunization Type selection with Print Now option

 

 

Step 3: Print Blank Immunization Form  

The Immunization Report window appears. 

1. Click Print to generate the blank immunization form 

2. The form prints with patient information pre-populated 

3. The system creates a pending immunization record 

 Immunization Report window 
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Blank form
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Status Update: 

After printing, the immunization record shows three status areas as: 

 Status: Printed Consent 

 Product status: Pending Claim 

 Fee status: Pending Claim 

Immunization record show the statuses 

 

 

Step 4: Complete the Paper Form 

Off-System Process: 

1. Administer the immunization to the patient 
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2. Complete all sections of the printed form: 

 Patient consent information 

 Product details (lot number, expiry date, etc.) 

 Administration details (date, site, administered by) 

 Patient/guardian signature 

 Pharmacist signature 

3. Ensure all required fields are completed and legible 

Important: The form must be fully completed before scanning. 

 

Step 5: Scan Completed Form into Kroll  

Access Document Scanning: 

1. From the Start Screen, navigate to Utilities > Printed Document Scan/Import 

2. Place the completed immunization form(s) on the document scanner 

3. Click Start Scanning 

4. Wait for the scanning process to complete 

5. Click Stop Scanning when all documents are scanned 

 Printed Document Scan/Import utility 
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📝 Note: Ensure all pages are attached as Kroll expects the same number of pages printed to be scanned back in. 

 

 

Step 6: Process Scanned Documents 

The Document Scan Reconciliation screen displays. 

1. Review the scanned documents list 

2. Click Process Pending Documents 

3. Wait for processing to complete 

4. Exit the utility to return to the Start Screen 

 Document Scan Reconciliation screen

 

What happens: The system links scanned forms to their corresponding pending Immunization records. 
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Step 7: Verify Scanned Form 

1. Return to the patient card 

2. Click Immunizations 

3. Locate the immunization record 

Status Update: 

The record now shows: 

 Status: Signed Consent (updated from Pending) 

 Completed Date: Now populated with the date 

Immunization record showing Signed Consent status

 

 

Step 8: View Scanned Form (Optional)  

To view or print the scanned form: 

1. Highlight the immunization record 

2. Press F2 to open the Immunization View 

3. The scanned form displays 
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Immunization View showing scanned document

 

To print the scanned form: 

1. Click the Printer icon in the upper left corner 

2. The Print dialog displays 

3. Click OK 

4. The scanned form prints 
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Print scanned document
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Step 9: Enter Immunization Data Electronically  

Important: Even though the paper form is complete, data must be entered electronically for transmission to Imm/ARI. 

1. From the patient's Immunizations screen, highlight the immunization record 

2. Press F (Claim Fee) or select Claim Fee from the menu 
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Immunizations screen with Claim Fee option

 

The Immunization Data Entry window opens. 

 

Step 10: Complete Required Data Entry  

Product Tab: 

Enter all required fields by referencing the completed paper form: 

 Product details 

 Lot number 

 Expiry date 

 Quantity 

 Vaccine type 

 Manufacturer 

Click Next. 
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Product tab in Immunization Data Entry

 

📝 Note: The ‘Record on network’ checkbox is greyed out. The immunization will automatically be transmitted to the 

network.

 

Step 11: Locations Tab 

Verify and complete location information: 

Patient Address: 

 Auto-populates from patient profile 

 Province, Postal Code, and Country are editable 

 Check Homeless if applicable 

Store Address: 
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 Auto-populates from store configuration 

Click Next. 

Locations tab

 

 

Step 12: Administration Tab 

Enter all required administration details: 

Field Description Source 

Date of admin Date vaccine was administered From paper form 

Administered by Healthcare provider who administered Dropdown selection 
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Field Description Source 

Administration site Injection location Dropdown selection 

Administration reason Reason for immunization Dropdown (vaccine-specific) 

Administration fee Fee for service billing Dropdown (if non-publicly funded) 

* All required fields must be completed to enable the Record button. 

Click Record. 

Administration tab with required fields

 

 

Step 13: Bill Immunization Product  

The F12 Fill Rx screen opens for the immunization product. 

1. Verify all information is correct: 
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 Product matches the administered vaccine 

 Quantity is correct 

 Date matches the administration date 

 Patient information is accurate 

2. Complete the prescription filling process 

3. Process adjudication 

F12 Fill screen for immunization product

 

 

 

Step 14: Bill Administration Fee (if applicable)  

If an administration fee was selected, the F12 Fill Rx screen opens again for the fee-for-service billing. 

1. Verify the fee drug card is correct (e.g., PDIN 00071111 or 00081111) 

2. Complete the prescription filling process 
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3. Process adjudication 

F12 Fill screen for administration fee

 

 

Step 15: Verify Transmission to Network  

After completing all billing: 

1. Return to the patient's Immunizations screen 

2. Locate the immunization record 

3. Verify the cloud symbol (☁) appears next to the record 

Cloud Symbol Indicates: 

 ✅ Immunization successfully uploaded to Imm/ARI and PIN 

 ✅ Data transmission complete 

 ✅ Record is now part of the provincial immunization registry 
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 Immunization record with cloud symbol indicating network upload  

 

Printing Completed Forms 

To print a copy of the scanned immunization form: 

Method 1: From Immunization View 

1. From the Immunizations screen, highlight the immunization record 

2. Press F2 to open Immunization View 

3. Click the Printer icon in the upper left corner 

4. Click OK in the Print dialog 

5. The scanned form prints 

Method 2: From Documents Tab 

1. Press F2 to open Immunization View 

2. Click the Documents tab 

3. The scanned consent form displays 

4. Click the Printer icon 

5. The form prints 

 

Paper Mode vs. Electronic Mode Comparison 

Aspect Paper Mode Electronic Mode 

Initial documentation Print blank form, complete manually Enter data directly in Kroll 
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Aspect Paper Mode Electronic Mode 

Patient signature Physical signature on paper Electronic signature pad (if configured) 

Data entry timing After administration and scanning During administration process 

Scanning required Yes - completed forms must be scanned Optional - consent forms only 

Steps to complete More steps (print, fill, scan, enter data) Fewer steps (direct data entry) 

Network transmission Automatic after data entry Automatic after finalization 

 

Important Notes 

📋 Documentation Requirements:  

 Paper forms must be fully completed and signed before scanning 

 Scanned forms are stored electronically in Kroll 

 Electronic data entry is still required for Imm/ARI transmission 

 Maintain paper forms according to pharmacy record retention policies 

⚠ Common Mistakes to Avoid: 

 ❌ Scanning incomplete forms (all fields must be filled) 

 ❌ Forgetting to complete electronic data entry after scanning 

 ❌ Not verifying the cloud symbol appears (confirms network upload) 

 ❌ Assuming scanning alone transmits data to Imm/ARI 

✅ Best Practices: 

 Complete paper forms immediately after administration 

 Scan forms promptly to avoid backlog 

 Verify scanned image quality before processing 

 Complete electronic data entry the same day 

 Check for cloud symbol to confirm successful upload 



67 

 

 

Recording Emergency Epinephrine Shots (Paper mode) 

Record an epinephrine injection when: 

 A patient experiences an adverse reaction to an immunization 

 Epinephrine was administered as emergency treatment 

 The immunization record is already completed in Kroll 

 Your system is configured for Paper mode immunization processing 

📝 Note: The epinephrine administration is linked to the specific immunization that caused the 

reaction and is reported to Imm/ARI and PIN.

 

Prerequisites 

Before using this feature, ensure: 

 ✅ Epinephrine products are configured in Kroll drug cards 

 ✅ The original immunization record is completed in Kroll 

 ✅ Paper mode is enabled (File > Configuration > Store > Rx > 8 - Immunization) 

 

Step-by-Step Documentation Procedure 

Step 1: Access the Patient Profile  

1. Press F3 to search for and open the patient profile 

2. In the right-hand ribbon under View, select Immunizations 

 

Step 2: Link Epinephrine to the Immunization Record  

1. Locate the immunization record that caused the adverse reaction 

2. Right-click on the immunization record 

3. Select Add Epinephrine shot 
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Right-click menu with "Add Epinephrine shot" option 

 

Important: Select the specific immunization that triggered the adverse reaction. The epinephrine 

administration will be linked to this record. 

 

Step 3: Complete Immunization Data Entry  

The Immunization Data Entry window opens, displaying all required fields on a single screen 

Immunization Data Entry window for epinephrine (Paper mode)

 

 

Product Information 

Field Description Example/Notes 

Product* Epinephrine product administered Select from dropdown (e.g., EpiPen, EpiPen Jr.) 

Disp Qty* Quantity administered Typically 1 

Route* Administration route Intramuscular (IM), Subcutaneous (SC) 

Lot Number* Product lot number From epinephrine packaging 
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Field Description Example/Notes 

Expiry Date* Product expiration date From epinephrine packaging 

Administration Information 

Field Description Example/Notes 

Date of admin* Date epinephrine was administered Auto-populated with current date/time (editable) 

Administered by* Healthcare provider who administered Select from dropdown (Edit > Users and Groups) 

Administration site* Injection location Select from dropdown (e.g., Left thigh, Right thigh) 

All fields marked with an asterisk (*) must be completed before you can proceed.  

Click Next. 
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Completed Immunization Data Entry fields

 

 

Step 4: Administration tab 

1. Enter the required information indicated by an * 

2. Click Record 
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Record button enabled after completing required fields

 

What happens: The system saves the epinephrine administration and links it to the immunization record. 

 

Step 5: Bill Epinephrine Administration  

After clicking Record, the F12 Fill Rx screen opens with the epinephrine pre-populated 

1. Verify all information is correct: 

 Product matches the epinephrine administered 

 Quantity is correct 

 Date/time reflects the emergency administration 

2. Complete the prescription filling process 
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Step 6: Notify Patient's Prescriber  

Important: In Paper mode, prescriber notification is not available for the Emergency Epinephrine administration.  

Manual notification required:  

1. Contact the patient's primary healthcare provider by phone, fax, or secure messaging 

2. Inform them of: 

 The adverse reaction 

 Epinephrine administration 

 Patient's current condition 

 Any follow-up care provided 

3. Document the notification in the patient's pharmacy records 

Alternative: Generate a notification letter using your pharmacy's standard procedures. 

 

Recording an Immunization from the F12 - Fill screen 

This workflow allows you to process immunizations using the standard prescription filling screen (F12 Fill Rx) instead of t

he dedicated Immunization module. When you fill an immunization product, Kroll automatically prompts you to complete 

the immunization documentation.  

When to Use This Method: 

 You prefer the traditional prescription filling workflow 

 You're processing immunizations alongside other prescriptions 

 You're more familiar with F12 Fill than the Immunization module 

 You want to bill the product first, then complete immunization details 

Result: The immunization is documented and transmitted to Imm/ARI and PIN,   

 

Step 1: Open F12 Fill Rx Screen and complete prescription 

1. Access the prescription filling screen and enter all the details. 

2. Click F12 - Fill Rx (or press F12) 
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F12 Fill Rx screen

 

 

Step 2: Immunization Data Entry Window Appears  

After successfully filling the prescription, the Immunization Data Entry window automatically displays. Once all required 

fields are entered, click Next to proceed and complete through the Location and Administration tabs then finally click 

Record. 

The prescription and immunization are now recorded on PIN and Imm/ARI 
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Step 3: Verify Successful Transmission 

After completing all steps: 

1. Navigate to the patient's Immunizations module 

2. Locate the newly created immunization record 

3. Verify the cloud symbol (☁) appears next to the record 

Cloud Symbol Indicates: 

 ✅ Immunization successfully uploaded to Imm/ARI and PIN 

 ✅ Data transmission complete 

 ✅ Record is now part of the provincial immunization registry 

Immunization record with cloud symbol 
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Completing Immunizations that are ‘Saved for Later’ 

Call up a patient using F3 - Patient search or select an immunization from the F9 - Workflow screen. On the right-hand 

ribbon, under the View section, select Immunizations. 

1. Call up the Patient Profile using F3 - Patient or selecting an incomplete immunization in F9- 

Workflow.  

2. On the right-hand ribbon, select Immunizations.  

3. Highlight the immunization (hit spacebar) 

4. Type ‘F’ to Call up and complete the immunization as outlined in previous steps. 

 

 

Cancelling a Vaccine 

A Vaccine can be cancelled from either the F3 - Patient or the F9 - Workflow screen. However, an immunization that is 

completed entirely will no longer appear in F9 - Workflow under the Immunizations tab and must be cancelled from the 

Patient immunization screen. 
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F3-Patient/Immunization

 

F9-Worklow/ Immunization

  

5. Call up the Patient Profile using F3 - Patient or selecting an incomplete immunization in F9- 

Workflow.  

6. On the right-hand ribbon, select Immunizations.  

7. Highlight the appropriate immunization record and select C - Cancel Claim. The claim will begin the 

reversal process without further prompting. 

📝 Note: If a Fee for Service was billed for the Immunization, the fee portion of the record will be reversed first, and then 

the immunization product will be reversed thereafter. These reversals are found under the Rxs Filled in Error profile on 

the patient card. 
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Refused Immunizations 

All refused Immunizations must be recorded on the Immunization Network. The patient or pharmacist may refuse an 

immunization that is not completed at any time, however, if the immunization is not recorded on the network first, an error 

will display indicating the missing data required. 

 

Choose OK on this message and select Next to continue to the Product tab. On this tab enter the required information and 

then select Refuse Immunization. 
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The Patient Ineligible form opens, allowing the user to select from Declined by Pharmacist, Patient Refused or Patient 

Ineligible and then select a Reason. This will be recorded on the network. 

Refused Immunizations will appear on network as one entry per antigen after selecting OK. 
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If an immunization has more than one antigen, it will be recorded on the network as refused for each antigen. 
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(Network) Patient Profile  
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Immunization Batch Lookup 

What is Immunization Batch Lookup? 

This tool allows you to locate immunization records that were initially accepted by Imm/ARI but later rejected during 

validation processing. When the network identifies issues with submitted immunizations, you will receive notification with 

batch numbers to help identify and correct the affected records. 

When to Use This Feature: 

 You receive a rejection notification email from Alberta Health 

 Immunizations were initially accepted but later flagged for errors 

 You need to locate specific immunization records by batch number 

 You must correct and retransmit rejected immunizations 

 

Why this happens: Imm/ARI performs additional validation after initial submission. Issues discovered during this process 

trigger rejection notifications, even though the submission appeared successful initially. 

 

Understanding Rejection Notifications 

Email Source: 

Rejection notifications are sent from Alberta Health's Imm/ARI system. 

Email contains: 

 Batch Number(s): Unique identifier for the affected immunization submission 

 Rejection Reason(s): Description of the validation error 

 Patient Information: May include partial patient details (depending on the error) 

 Instructions: Guidance on correcting and resubmitting 

Sample Email: 
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Sample rejection notification email from Alberta Health

 

 

Common Rejection Reasons:  

Rejection Reason Description Common Cause 

Invalid vaccine code Vaccine type doesn't match product Incorrect vaccine selection in Product tab 

Invalid lot number Lot number format incorrect Typo or invalid characters in lot number 

Expired vaccine Expiry date has passed Vaccine administered after expiration 

Invalid administration site Site code not recognized Incorrect selection from dropdown 

Missing required field Mandatory data not provided Incomplete data entry 

Duplicate record Immunization already exists Record submitted multiple times 

Invalid patient information Patient demographics don't match PHN or demographic mismatch 

 

Step-by-Step: Using Immunization Batch Lookup 

Step 1: Receive and Review Rejection Email  

1. Check your pharmacy email for notifications from Alberta Health 

2. Locate the rejection notification email 
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3. Identify the following information: 

 Batch Number (required for lookup) 

 Rejection Reason (explains what needs correction) 

 Patient details (if provided) 

Important: Keep the email for reference. You will need the rejection reason to correct the issue. 

 

Step 2: Access Immunization Batch Lookup 

1. From the Kroll main menu, navigate to Network > Immunization Batch Lookup 

2. The Immunization Batch Lookup window opens 

Imm/ARI Immunization Batch Lookup Search 

 

 

Step 3: Enter Batch Number  

1. In the Batch ID field, enter the batch number from the rejection email 

 

 

Step 4: Retrieve the Record 

1. Click Call Up Patient 

2. The system searches for the immunization record linked to the batch number 

3. The corresponding patient and immunization record display 
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Imm/ARI Batch search with Batch ID field 

 

 

To Correct a Vaccine noted on the Imm/ARI Batch 

Step 1: Access Patient Immunization History  

1. Press F3 to search for and open the patient profile 

2. In the right-hand ribbon under View, select Immunizations 

3. The patient's immunization history displays 

 

Step 2: Locate the Rejected Immunization  

1. Review the immunization list 

2. Identify the rejected immunization record using: 

 Date of administration  (from rejection email or Batch Lookup) 

 Vaccine type (matches the rejected record) 

 Status indicators (may show error or pending status) 

3. Highlight the rejected immunization record 
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Rejected immunization record highlighted

 

Tip: The rejected record may not have a cloud symbol (☁), indicating failed transmission to Imm/ARI. 

 

 

Step 3: Cancel the Rejected Claim  

1. With the rejected immunization highlighted, select Cancel Claim 

 Method A: Click the Cancel Claim button 

 Method B: Right-click and select Cancel Claim from the menu 

 Method C: Use the keyboard shortcut (if available) 

 

Step 4: Complete Prescription Details with corrections  

Enter all prescription information in the F12 Fill Rx screen: 

1. Select the correct Product (immunization vaccine) 

2. Enter Quantity (typically 1) 

3. Complete all required fields 

4. Do NOT click F12-Fill Rx yet 

5. Backdate the Prescription 

Important: The prescription must be backdated to the original administration date. 
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6. The Back Date Rx dialog appears 

7. Enter the original administration date  (the date the vaccine was actually given to the patient) 

1. Use the date from the cancelled immunization record 

2. This should match the date in the rejection email or Batch Lookup results 

8. Click OK 

Back Date Rx dialog with date entry  

Why this matters: Backdating ensures the immunization appears in the patient's provincial record with the correct histori

cal date, maintaining an accurate immunization timeline. 

 

9. Complete Prescription Filling 

 Verify the prescription date now shows the backdated date 

 Click F12-Fill Rx to continue 

 Complete the prescription filling process as normal 

 Process adjudication (if applicable) 

 

Step 5: Complete Immunization Data Entry  

The Immunization Data Entry window appears (if using F12 Fill method) or continue through the immunization module ta

bs. 

 

Product Tab: 

1. Complete all required fields: 

 Lot Number (verify accuracy - this may have been the error) 

 Expiry Date (verify accuracy) 
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 Vaccine (ensure correct vaccine type is selected) 

 Manufacturer 

 Change the date to the original administered date for the patient. 

2. Double-check the corrected field that caused the original rejection 

3. Click Next 

 

 

 

Step 6: Record the Corrected Immunization  

1. After validating all data is correct, click Record 

2. The system saves the immunization and transmits to Imm/ARI 

3. Complete any additional prompts: 

 Administration fee billing (F12 Fill screen appears if fee selected) 

 Immunization follow-up options 

 Print immunization record prompt 
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Network Patient Profile 

The patient’s immunization claims are viewable on the (Network) Patient Profile under the Immunizations tab. 

 

To display additional information detail the vaccine, press ‘D’ and the (Network) Immunization Detail window opens.
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Influenza and Covid-19 

This user guide has been created towards inserting Non-Influenza drug products. The Influenza and COVID-19 immunizations 

will follow the same workflow with the following differences: 

 The Patient Consent questions are aligned with the appropriate Immunization. 
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 The list of products available for selection will be specific to the Immunization workflow chosen. 
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Status Types 

Status 

• Completed: The immunization has been completed and the claim has been recorded. 

• Completed Paper: The immunization has been completed in Paper mode. 

• Declined by Pharmacist : The immunization has been declined by the pharmacist; no claim has been sent to the 

network. 

• Patient Consent Scan Skipped : The patient consent has not yet been scanned; claim has not been sent to the 

network. 

• Pending: The immunization is incomplete or has been marked as ‘Saved for Later’; no claim has been sent to the 

network 

• Printed Consent: The patient consent form has been printed, but not scanned back into the system; no claim has been 

sent to the network (Paper mode only). 

• Ready for Administration: An Emergency Epinephrine shot function has been initiated, but is incomplete or has been 

marked as ‘Saved for Later’; no claim has been sent to the network  

• Refused by Patient: The immunization has been refused by the patient; no claim has been sent to the network. 

• Signed Consent: The patient consent form has been scanned back into the system. 

Product Status 

• Claimed: The immunization or Emergency Epinephrine shot is complete; claim has been sent to the network. 

• Not Completed Yet: The immunization or Emergency Epinephrine shot is incomplete or has been marked as ‘Saved 

for Later’. 

• No Product Applicable: The immunization or Emergency Epinephrine shot has been declined by the pharmacist or 

refused by the patient. No product has been administered nor has a claim been sent to the network. 

• Pending Claim: The immunization or Emergency Epinephrine is complete; claim has not been sent to the network. 
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Fee Status 

• No Fee Applicable: When filling an immunization product, selecting ‘Free Of Charge’ in the Administration fee field will 

automatically waive the fee portion. 

• Not Completed Yet: The Immunization or Emergency Epinephrine shot is incomplete or has been marked as ‘Saved 

for Later’. 

• Pending Claim: The Immunization or Emergency Epinephrine shot is complete; claim for Fee for Service has not been 

submitted. 

 


